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Overview of Manual 

This manual has been designed to get you up and running as quickly as possible with CHEMKIN 
Release 3.6.  The organization of the manual is:  
 
    Chapter Chapter Chapter Chapter     DescriptionDescriptionDescriptionDescription    

1. What’s New in Release 3.6 A description of the new features in CHEMKIN Release 3.6. 

2. System Requirements Operating system and computer hardware requirements for 
installing and running CHEMKIN Release 3.6. 

3. Installation and Quick Start Installation instructions for Windows and UNIX computers. 
Quick-start instructions for users already familiar with 
CHEMKIN. 

4. Introduction to the CHEMKIN 

Collection 
A brief overview of the CHEMKIN Collection Utilities and the 
Applications, as well as background information on 
Reaction Design. 

5. Problem Solving with the 
CHEMKIN Collection 

Basic strategy for problem formulation and solution using 
the CHEMKIN Collection.  Guidelines for running programs 
and interpreting results. 

6. The CHEMKIN Application User 
Interface 

An introduction to the CHEMKIN Application User Interface. 

7. The CHEMKIN Graphical Post- 
Processor 

An introduction to the CHEMKIN Graphical Post Processor. 

8. Using CHEMKIN from the 
Command Line 

Instructions for using CHEMKIN from the command line in 
an MS-DOS prompt or UNIX shell. 

9. Getting Help and Support Where to go for more information. 
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1. What’s New in CHEMKIN Release 3.6 

The CHEMKIN Collection is a powerful system for solving complex chemical modeling problems.  
CHEMKIN is composed of standalone Applications, as well as subroutine libraries and utilities that can be 
used to create new problem solving environments.  CHEMKIN facilitates the formulation, solution, and 
interpretation of problems involving gas-phase and heterogeneous (gas-surface) chemical kinetics. A 
wide range of chemical process modeling problems can be addressed including:  combustion, catalysis, 
corrosion, plasma etching and chemical vapor deposition.  
 
Many new features and enhancements have been incorporated by Reaction Design into Release 3.6, 
including:  

• Transient stirred-reactor capability.  You can now run AURORA in either transient or steady-state 
mode.  This allows simulation of engine cycles, pulsed plasma, reactor startup, as well as many 
other applications.  The transient capability includes sensitivity analysis for species and 
temperature, for both gas and surface reactions. 

• Options in AURORA, PLUG, SENKIN, and PREMIX allow you to specify profiles that vary as a 
function of time or distance through keyword input.  These options include profiles of varying 
temperature, heat loss, pressure, volume, and power.  They eliminate the need for programming 
and compiling of user subroutines. 

• The CHEMKIN Graphical Post-processor now allows you to import more than one solution set 
simultaneously, and allows generation of plots from more than one solution set.  This allows 
plotting of simulation results against imported experimental data, for example, as well as plotting 
of one simulation result against another when one grid is more refined. 

• OPPDIF now includes sensitivity analysis for reaction and heat-of-formation sensitivity. 

• All of the Command-Line FORTRAN Post-processors have been re-structured to output text 
files as comma-delimited columns of data that may be easily imported into the Graphical Post-
processor as well as into Excel or other third-party analysis packages.  These FORTRAN post-
processor routines read and process the binary solution files, are distributed as source-code, and 
allow users to tailor post-solution analyses to their own specific needs. 

 
Getting started with CHEMKIN is easy; the installation takes just a few minutes.  This manual guides you 
through the installation process and helps you navigate through the graphical user interfaces.  Additional 
details about the CHEMKIN Applications and Utilities are provided in a complete set of user manuals.  The 
distribution CD for the CHEMKIN Collection contains all of the program documentation, as well as a set of 
sample problems for each of the Applications.    
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2. System Requirements 

Before you start, take a minute to verify that you have what you need to install and run CHEMKIN: 
 

1. A suitable computer and operating system. CHEMKIN Release 3.6 will run on the following 
platforms:  

 

Manufacturer Operating System 

Compaq (Digital) Tru64 (Alpha) UNIX 4.0D or higher 

Hewlett Packard HP-UX 10.x 

Silicon Graphics SGI IRIX 6.x 

Sun Microsystems Sun Solaris 2.6 

PC-compatible 

Win32: 
Windows NT 4.0 (i386 with Service Pack 5 or later) 
Windows 95 
Windows 98 
Windows 2000 

 

2. 60 Megabytes of hard disk space. 

3. 64 MB of RAM (128 MB recommended).  Note:  You may need more memory if you plan to run 
very large problems (e.g. problems that involve more than 100 species). 

4. A valid license file for the CHEMKIN software 

5. Access to the documentation for the applications that you intend to run. 

 

To use CHEMKIN, you should be familiar with the basics of the operating system on your computer. You 
should know how to use the mouse, how to use menus, manage files and how to enter text.  If you are 
unsure about any of these techniques, we recommend that you consult the documentation that came with 
your computer. 
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3. Installation and Quick Start 

3.1 OVERVIEW OF THE INSTALLATION PROCESS 

Installation of the CHEMKIN Collection involves three basic steps: 
 

1. Install the software from the CD-ROM (or web download). 

2. Obtain and install a CHEMKIN license file from Reaction Design. 

3. Run one or more of the samples problems to make sure that the software is installed correctly. 

 
Each of these steps are described in more detail in the following sections.  The instructions are divided 
according to platform.  Section 3.2 describes installation procedures for all Windows-based PCs, while 
Section 3.3 describes installation procedures for all UNIX platforms.   
 

3.2 PC INSTALLATION AND LICENSING 

3.2.1 Running the Setup Program 

To install CHEMKIN on your Win32 computer (Windows NT, 95, 98, or 2000), perform the following steps:  
 

1. Insert the CHEMKIN distribution CD-ROM into your CD-ROM drive.  After a short delay, the 
autoplay program starts.  Note:  If the autoplay program does not start automatically on your 
computer, double click on your “My Computer” icon and browse to your CD-ROM.  Inside the 
subfolder install, locate the chemkin36_pc_setup.exe  file and double-click on this.   

2. The program will first prompt you to extract the needed files.  Click “Setup” to continue. 

3. The Welcome dialog introduces you to the Setup program and informs you of several restrictions 
and cautions.  Click “Next” to continue. 

4. The next dialog contains some more information about the Release. Click “Next” to continue with 
the installation. 
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5. Choose the Destination Location.   This is the location on your hard disk where you would like to 
install CHEMKIN.  The default is “c:\chemkin36”, but you may select any drive or folder name.  
To choose a different location from the default, click “Browse” and select a location from the 
Choose Directory dialog.  Once you have made your choice (or if you decide to keep the default), 
click “Next” to continue the installation.  Click “Cancel” to leave the installation program and 
return to Windows. 

6. Choose the Setup Type.  This allows you to customize what parts of CHEMKIN get installed.  We 
recommend choosing “Typical”.  If you choose “Compact,” you will not install most of the online 
documentation.  Once you have made your selection, click “Next” to continue. 

7. Choose the short-cut labels for your Start→Programs menu.  Modifying the settings here changes 
the way the short-cuts are organized in your Programs menu.   Click “Next” to continue.  At this 
point the Setup program will begin installing files on your computer’s hard disk.   

8. After the files have been installed successfully, the setup dialog will ask you to reboot your 
computer.  Choose “Yes” to allow the program to reboot, or “No” to reboot manually later.  The 
reboot step is necessary to register a default license-file location in your system registry.   

 

3.2.2 Modifying your “Path” 

We recommend that you modify your “path” variable to include the “c:\chemkin36\bin” directory, 
particularly if you plan to run from the command line, rather than using the Application User Interface.  
The following steps will add “c:\chemkin36\bin” to your path.   Note that the instructions are 
different for Windows NT and Windows 2000 than for Windows 95 and Windows 98 operating systems. 

Windows NT or Windows 2000:Windows NT or Windows 2000:Windows NT or Windows 2000:Windows NT or Windows 2000:    

1. Right-click on your computer icon on your desktop and choose “Properties” from the system 
menu.   

2. NT: Select the “Environment” tab. 

2000: Select the “Advanced” tab.  Select “Environment Variables” 

3. NT: Under the “User Variables for <your user name>”, browse for and select the “path”.   

2000: Under the “User Variables for <your user name>”, browse for and select the “PATH” 
and choose “Edit”.   

4. In the “Value” field, scroll to the end of the text box and add a semicolon “;” followed by the full 
path to your CHEMKIN “bin” directory (e.g., c:\chemkin36\bin).  Click “Set” and then “OK”. 



Installation and Quick Start 
 

 
13

Windows 95 and Windows 98:Windows 95 and Windows 98:Windows 95 and Windows 98:Windows 95 and Windows 98:    

1. Open your autoexec.bat file, located in the root of your “C” disk, using your favorite text 
editor (e.g. Notepad). 

2. Add the following line near the top of the file (substituting the correct path to your CHEMKIN 
“bin” directory if you have not installed in the default location): 

set PATH=%PATH%;c:\chemkin36\bin

3. Save the file and exit the editor. 

4. Restart your computer for the change to take effect. 

 

3.2.3 Uninstalling CHEMKIN 

After you have installed CHEMKIN with the above steps, it is possible to remove it from your system if 
necessary.  Open the “Add/Remove Programs” folder in the Control Panel (under “Settings” from the 
“Start” menu).  Select “CHEMKIN 3.6” from the “Install/Uninstall” tab and click “Add/Remove”.  Note:  
If you have added files to or modified files in the CHEMKIN installation, the Uninstall process will not 
automatically remove these files. 
 

3.2.4 PC Licensing Overview 

You must obtain and install a set of license keys in order to run the CHEMKIN Collection software.  This 
section provides instructions on how to obtain and install a Reaction Design license file for the CHEMKIN 
Collection after you have purchased the software.  For purchasing information, contact by email:  
CHEMKIN@ReactionDesign.com.    
 

Assumptions:Assumptions:Assumptions:Assumptions:    

We assume the following, for purposes of providing instructions on obtaining and installing a license on 
a PC: 

1. You have already installed CHEMKIN Release 3.6 on your computer. 

2. The default installation directory for your PC is c:\chemkin36.  If you have installed in a 
different location, please make the necessary replacements in the instructions that follow. 
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Required Tasks:Required Tasks:Required Tasks:Required Tasks:    

1. Request a license from Reaction Design, providing information about your computer. 

2. Install the license received from Reaction Design. 

 

3.2.5 Request a License from Reaction Design 

To obtain a license from Reaction Design, we require that you send us certain information about the 
computer on which you will be running CHEMKIN.  Here we provide detailed instructions for obtaining 
that information.  If you have purchased a Network (Simultaneous Active User) License, the following 
steps should be run on your Network License Server.    
 
For CHEMKIN 3.6, we have added a new license utility for the PC.  A short-cut to this utility is installed in 
your Windows Start→ Programs Menu.  Follow the steps below to send your computer’s identifying data 
to Reaction Design: 

1. With your mouse, click on:   
Start →→→→ Programs →→→→ CHEMKIN Collection 3.6 →→→→ Licensing →→→→ 
Request A New CHEMKIN License 
The “RequestLicense” utility should open a dialog box. 

2. From the initial dialog box, choose “Get a New License” and click OK 

3. In the “Get A License” dialogue box, fill in your Personal Information. 

4. Choose one of the following: 

a. Email Info:   (To email the information gathered to Reaction Design) 

b. Web Form:   (To post the information gathered via a web browser) 

c. Save:   (To save the information gathered to a file to be retrieved later).  Use this if your 
computer is not connected to the internet.  The information is saved as 
c:\chemkin36\licenses\request.txt.  Email the contents of this file to 
CHEMKIN@ReactionDesign.com. 

Upon receipt of your computer information, Reaction Design will generate a set of license keys, specific to 
your computer and to the selection of CHEMKIN modules that you have purchased.  These license keys 
will be sent to you by email.  The next two sections describe how to install the license keys on your PC.  If 
you have purchased a Node-locked license, follow the instructions in Section 3.2.6; if you have purchased 
a Network license, proceed to Section 3.2.7. 
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3.2.6 Installing a Node-locked (or DEMO) License 

Once you have received an email with license keys from Reaction Design, you will need to place the 
license keys in the correct location.   
 

• If the license file arrives as an email attachment, simply save the attachment as a file named 
“chemkin.lic” in the “licenses” sub-folder of your CHEMKIN installation (e.g. save as 
“c:\chemkin36\licenses\chemkin.lic”).   

• If the license keys are embedded in the email text, simply cut and paste this information into an 
empty text file, using your favorite editor (e.g. Notepad).  Save this file as 
“c:\chemkin36\licenses\chemkin.lic”.  Be sure that Notepad does not inadvertently add an 
extra “.txt” extension onto the end of the file name.  To view the file extension, you can open an MS-
DOS Prompt, change directories to the “c:\chemkin36\licenses” folder and type “DIR”; the 
full file name of the license file should be listed. 

 
You are now ready to run CHEMKIN; Skip the following sections and go directly to Section 3.4 
 

3.2.7 Installing a Network (Simultaneous Active User) License 

In network licensing, more than one user may be running CHEMKIN Applications by accessing a centrally 
located license file that resides on a Network License Server.  The license allows one or more 
simultaneous active users to run CHEMKIN Applications.  Clients of the Network License Server should 
have their own local installation of CHEMKIN, but obtain a license from the Server while the CHEMKIN 

Application is running.  The instructions here describe what needs to be done on both the Network 
License Server and on the Client machines. 
 

On the Network License Server:On the Network License Server:On the Network License Server:On the Network License Server:    

1. Install the license as described in Section 3.2.6 (assuming that the Server is a PC).   

2. Edit the license file using your text editor of choice: 

a. Change the text “servername” in the line: 
SERVER servername

to the name (e.g. “MYCOMPUTER”) or IP Address (e.g. “192.168.0.1”) of the 
Network License Server. 

b. On the DAEMON line, verify that the PATH to reaction.exe is correct; the default 
location is:  c:\chemkin36\licenses\reaction.exe 
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3. Launch LMTOOLS by selecting with your mouse from the Start→Programs Menu.  Click on 
Start → Programs→ CHEMKIN Collection 3.6 → Licensing → 
Manage CHEMKIN Licenses.  This should start the LMTOOLS utility window. 

a. Click on the “Configuration using Services” option (radio button). 

b. Click on “Configure Services” tab. 

c. Browse for the location of  lmgrd.exe.  With default installation, this will be: 
c:\chemkin36\licenses\lmgrd.exe 

d. Browse for the license file location.  This will be the location used in Step 1 above. 

e. It is recommended that you keep a log file.  In the log path, type in:  
c:\chemkin36\licenses\debug.log

f. Check the boxes “Use Services” (NT) and “Start server at Power Up”.   

g. Press the “Save Service” button and click “Yes” to save the settings. 

h. Select the “Start/Stop/Reread” tab. 

i. Click “Start” to start the daemon service on the Server. 

j. Choose “Exit” from the “File” pull-down menu. 

On each Network Client:On each Network Client:On each Network Client:On each Network Client:    

1. Place a copy of the modified Network license file in the licenses sub-directory of the client 
CHEMKIN 3.6 installation; by default this will be: 

Windows/PC Client:Windows/PC Client:Windows/PC Client:Windows/PC Client:    

c:\chemkin36\licenses\chemkin.lic

UNIX Client:UNIX Client:UNIX Client:UNIX Client:    

$HOME/chemkin36/licenses/chemkin.lic

 

2. Now the client will be able to check out a license through the Server daemon.  

 
You are now ready to run CHEMKIN; Skip the following sections and go directly to Section 3.4 
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3.3 UNIX INSTALLATION AND LICENSING 

This section provides detailed instructions for installing CHEMKIN on any one of our supported UNIX 
platforms.  
 

3.3.1 Mounting the CHEMKIN Distribution CD-ROM 

Insert the CHEMKIN distribution CD-ROM into a mounted CD-ROM drive.   You must then mount the 
disk as a file system on your computer.   Note:  on most systems you must be root to mount a CD-ROM.   
Specific instructions for mounting the CD on supported platforms are as follows: 
 

Compaq Tru64 Compaq Tru64 Compaq Tru64 Compaq Tru64 UNIXUNIXUNIXUNIX (Digital Alpha):   (Digital Alpha):   (Digital Alpha):   (Digital Alpha):      

Mount the CD using Rock Ridge format by entering: 
/usr/sbin/mount –t cdfs –r –o rrip <CD-ROM-device> /cdrom

replacing <CD-ROM-device> with the actual name of the CD-ROM drive on your system.  A 
typical name is /dev/rz4c

HewlettHewlettHewlettHewlett----Packard HPPackard HPPackard HPPackard HP----UX:  UX:  UX:  UX:      

Mount the CD by entering: 
mount –r <CD-ROM-device> /cdrom

replacing <CD-ROM-device> with the actual name of the CD-ROM drive on your system.  A 
typical name is /dev/dsk/c1t2d0

SGI IRIX:  SGI IRIX:  SGI IRIX:  SGI IRIX:      

IRIX automatically mounts the CD when you insert it into the CD-ROM drive.  It is mounted as: 
/CDROM

Notes:  the installation instructions below assume that the CD-ROM is mounted at /cdrom.
You will therefore need to replace this with the actual path above (all upper case) as you follow 
the instructions below. 

SUN Solaris 2.6:  SUN Solaris 2.6:  SUN Solaris 2.6:  SUN Solaris 2.6:      

Solaris includes a “Volume Manager” that automatically mounts the CD when you insert it into 
the CD-ROM drive.  The CD will be mounted as:  

/cdrom/Chemkin36

Notes:  the installation instructions below assume that the CD-ROM is mounted at /cdrom.
You will therefore need to replace this with the actual path above as you follow the instructions 
below. 
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3.3.2 Executing the Installation Script 

If you are installing CHEMKIN into a public directory, make sure that you have root or similar privileges 
before running the installation script.  Once you have the correct permissions, open a UNIX shell and 
execute the installation script with the following commands  (Note: for SGI and SUN users, you must 
substitute the appropriate mount point for /cdrom below, as described in Section 3.3.1): 
 

cd /cdrom/install

/bin/sh /cdrom/install/chemkin36_unix_setup.sh

 
The installation script will echo information and prompt you for input as it proceeds through the 
following steps: 
 

1. Verify the current directory and the username.  Check that the directory printed is the install 
directory at the CD-ROM mount point.  Check that the user login has the correct privileges for 
installing to your desired destination.  If this information is correct, type “y” and <RETURN>. 

2. Choose the Destination Location.   This is the location on your hard-disk where you would like 
to install CHEMKIN and is the location where the install script will create a “chemkin” 
subdirectory.  The default is the directory identified by the environment variable, $HOME, or, if 
$HOME is not set on your computer, the default is $HOME.  The prompt asks if you want to use 
the default.  To accept the default, type “y” and <RETURN>.   To change the Destination Location, 
type “n” and <RETURN>, then type in the full path of your preferred destination and hit 
<RETURN> again. 

3. Create any needed directories.  If the directory you selected for the Destination Location does 
not already exist, you will be prompted to allow the install script to create the new directory.  
Type “y” and <RETURN> to continue with the install. 

4. Verify the platform for the installation.  The install script will determine which platform you are 
currently running on and will ask you whether this is the correct platform information.  If the 
information is correct, type “y” and <RETURN> to continue.  If you want to install onto a different 
platform than the one specified, type “n” and <RETURN>.  You will then be asked to choose from 
the list of available platforms and enter a corresponding number (e.g. “1” for Compaq (Alpha)).  
Type the number and <RETURN>.   

5. Verify all the information entered thus far before installing the CHEMKIN software.  If the 
information is correct, type “y” and <RETURN>.   
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6. Install the files.  The script will copy compressed tar files from the CD-ROM to your hard disk, 
uncompress and untar them into the Destination Location, and then delete the tar files.  When the 
installation is complete, information on setting environment variables needed to run CHEMKIN 
are displayed on your screen, using the UNIX more utility.  These instructions are also given 
below and in Section 3.3.4. 

 

3.3.3 Setting the CHEMKIN_DIR Environment Variable 

The UNIX version of the CHEMKIN software requires you to set an environment variable that points to the 
top-level directory where CHEMKIN was installed.  Although you could set the environment variables 
locally in a UNIX shell every time you run CHEMKIN, we recommend that you instead include the 
environment settings in your .cshrc (for C-shell users) or your .profile (for K-shell users) file, which 
will result in the variables being set automatically every time you open a new shell.  This section gives 
you detailed instructions for modifying these start-up files.  
 
The following instructions assume that you have installed CHEMKIN in the directory $HOME, such that the 
top-level CHEMKIN directory is $HOME/chemkin36.    If you have installed into a different location, or if 
the $HOME environment variable is not set for your user account, you will need to replace “$HOME” in the 
following instructions with the actual (absolute) path. 
 

1. Modify your .cshrc file (for C-shell users) or your .profile file (for K-shell users)  to include 
the environment variable CHEMKIN_DIR.  The command(s) that need to be added are shown 
below for the two shell environments: 

C-shell: setenv CHEMKIN_DIR $HOME/chemkin36 

K-shell: CHEMKIN_DIR=$HOME/chemkin36 

 export CHEMKIN_DIR

2. To verify that the CHEMKIN_DIR is set correctly, open a new shell and type: 

echo $CHEMKIN_DIR

This should result in an echo of the directory path to the top-level chemkin36 directory.  If not, 
verify that you have performed step 1 correctly; you may need to log-out and log back in to your 
computer for the changes to take effect. 
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3.3.4 Modifying your “Path” 

We recommend modifying your “path” variable to include the $HOME/chemkin36/bin directory (or the 
equivalent, if you installed elsewhere from  $HOME).  This will simplify the commands that you need to 
type to start the CHEMKIN Application User Interface, the CHEMKIN Graphical Post-processor, or to run 
programs from the command line.  The path variable can be modified in your .login or .cshrc files for 
C-shell users, or in your .profile for Bourne or Korn shell users with the following added line(s): 
 

C-shell: set path=( $path $HOME/chemkin36/bin ) 

K-shell: PATH=$PATH:$HOME/chemkin36/bin: 

 export PATH 

 
Note:  if you installed CHEMKIN in a different directory than $HOME, you will need to replace the actual 
(full) path in the above commands. 
 

3.3.5 UNIX Licensing Overview 

You must obtain and install a set of license keys in order to run the CHEMKIN Collection software.  This 
section provides instructions on how to obtain and install a Reaction Design license file for the CHEMKIN 
Collection, once you have purchased the software.  For purchasing information, contact by email:  
CHEMKIN@ReactionDesign.com.    

Assumptions:Assumptions:Assumptions:Assumptions:    

We assume the following for purposes of providing instructions on obtaining and installing a license on a 
UNIX workstation: 

1. You have already installed CHEMKIN Release 3.6 on your computer. 

2. The default installation directory for your UNIX workstation is $HOME/chemkin36.  If you 
have installed in a different location, please make the necessary replacements in the 
instructions that follow. 

Required Tasks:Required Tasks:Required Tasks:Required Tasks:    

1. Request a license from Reaction Design, providing information about your computer. 

2. Install the license received from Reaction Design. 
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3.3.6 Request a License from Reaction Design 

Once you have purchased a license, you will be asked to provide the “HOSTID” for the machine on 
which CHEMKIN will be installed, so that we can generate the needed license file.  You can get this 
information by changing directories to the licenses subdirectory of the CHEMKIN installation and 
running the command (in a UNIX shell):  
 

lmutil lmhostid

 
This returns the statement ‘The Flexlm hostid of this machine is “xxxx”’, where “xxxx” will be a unique 
identifier or HOSTID for your machine.   If the result is "ffffffffff", it probably means you don’t have a 
network card installed on your machine.  In this which case, issue the command  
 

lmutil lmhostid -vsn

 
This returns the statement ‘The Flexlm host ID of this machine is “DISK_SERIAL_NUM=101717e5”.’   
 
Once you have obtained a unique identifier, please send the following information to Reaction Design 
(email to CHEMKIN@ReactionDesign.com ) to receive your license file: 
 

1. The complete result of the “lmutil lmhostid” command.  

2. Your CHEMKIN License Number (located on your “License Specifications Form”).  

3. The Licensee Contact for your organization (located on your “License Specifications Form”).  

 
Upon receipt of your computer information, Reaction Design will generate a set of license keys, specific to 
your computer and to the selection of CHEMKIN packages that you have purchased.  These license keys 
will be sent to you by email.  The next sections describe how to install the license keys on your UNIX 
workstation. 
 

3.3.7 Installing a Node-locked (or DEMO) License 

After requesting a license, should receive by email a specific license to run CHEMKIN on your system. The 
file may have either UNIX or PC line-endings, depending on where and how you receive your email; if 
you need to transfer the license file from one machine to another, be sure to use ftp in ascii mode to 
guarantee the line endings get converted correctly.  Once you have received an email with license keys 
from Reaction Design, you will need to place the license keys in the correct location and set an 
environment variable to point to the license path, as described below: 
 



Installation and Quick Start 
 

 
22

1. Save the received license keys into a text file named “chemkin.lic” and copy the file into 
the directory $HOME/chemkin36/licenses. 

2. Set the environment variable called REACTION_LICENSE_FILE to point to the absolute path 
of the installed license file.  The specific instructions depend on the type of UNIX shell that 
you use: 

C-shell: 
a. Add the following line to your .cshrc file: 

setenv REACTION_LICENSE_FILE $HOME/chemkin36/licenses/chemkin.lic

b. Run the command: 
source .cshrc

K-shell or Bourne Shell: 
a. Add the following lines to your .profile file: 

REACTION_LICENSE_FILE=$HOME/chemkin36/licenses/chemkin.lic

export REACTION_LICENSE_FILE

b. Run the command: 
. .profile

Note:  if the environment variable REACTION_LICENSE_FILE has already been set for another 
product (i.e., another product from Reaction Design), simply append the license path to the 
existing one.  For example, if the existing definition is: 

 REACTION_LICENSE_FILE=$HOME/simulator/flight.lic, 

then modify it to be: 

 REACTION_LICENSE_FILE= \

$HOME/chemkin36/licenses/chemkin.lic:$HOME/simulator/flight.lic 

You are now ready to run CHEMKIN; Skip the following sections and go directly to Section 3.4 
 

3.3.8 Installing a Network (Simultaneous Active User) License 

In network licensing, more than one user may be running CHEMKIN Applications by accessing a centrally 
located license file that resides on a Network License Server.  The license allows one or more 
simultaneous active users to run CHEMKIN Applications.  Clients of the Network License Server should 
have their own local installation of CHEMKIN, but obtain a license from the Server while the CHEMKIN 

Application is running.  The instructions here describe what needs to be done on both the Network 
License Server and on the Client machines. 

On the Network License Server:On the Network License Server:On the Network License Server:On the Network License Server:    

1. Install the license as described in Section 3.3.7 (assuming that the Server is UNIX machine).   
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2. Edit the license file using a  text editor of your choice: 

a. Change the text “servername” in the line: 
SERVER servername ...

to the name (e.g. “MYCOMPUTER”) or IP Address (e.g. “192.168.0.1”) of the 
Network License Server. 

b. On the DAEMON line, verify that the PATH to reaction is correct; the default 
location is:  $HOME/chemkin36/licenses/reaction 

3. Start the Flexlm License Manager, lmgrd: 
(WARNING:  DO NOT RUN AS ROOT) 

a. cd $HOME/chemkin36/licenses. 

b. Type (using full path names to files): 

lmgrd –c $HOME/chemkin36/licenses/chemkin.lic \

-l $HOME/chemkin36/licenses/chemkin.log

c. Confirm that the daemon is actually running, using the following command.  The 
command should show a “lmgrd” process in the returned list:   

ps –ef | grep lmgrd

If the daemon lmgrd is not listed, check your log file for errors (e.g. 
“chemkin.log”).  If you need further assistance, send email to 
support@ReactionDesign.com. 

On each Network Client:On each Network Client:On each Network Client:On each Network Client:    

1. Place a copy of the modified Network license file in the “licenses” sub-directory of the client 
CHEMKIN 3.6 installation; by default this will be: 

Windows/PC Client:Windows/PC Client:Windows/PC Client:Windows/PC Client:    

c:\chemkin36\licenses\chemkin.lic

UNIX Client:UNIX Client:UNIX Client:UNIX Client:    

$HOME/chemkin36/licenses/chemkin.lic

2. Now the client will be able to check out a license through the Server daemon. 

You are now ready to run CHEMKIN; Skip the following sections and go directly to Section 3.4 
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3.4 RUNNING THE SAMPLE PROBLEMS 

Once CHEMKIN 3.6 and an appropriate license have been installed, you can launch the CHEMKIN 
Application User Interface and run any of the sample problems with just a few mouse clicks.   
 

3.4.1 Launching the CHEMKIN Application User Interface 

The way to launch the CHEMKIN Application User Interface depends on your platform: 

Windows/PC:  Windows/PC:  Windows/PC:  Windows/PC:      

In this case, the install program will have placed an icon labeled “CHEMKIN Collection 3.6” 
on your desktop.  Just double-click the “CHEMKIN Collection 3.6” icon to launch the 
Application User Interface.  You can also access either the CHEMKIN Application User Interface or 
the CHEMKIN Graphical Post-processor from the Windows Start → Programs → 
CHEMKIN Collection 3.6 menu. 

UNIX:  UNIX:  UNIX:  UNIX:      

If you set your “path” variable as instructed in Section 3.3.4 above, then you can open a UNIX 
shell and simply type: 

chemkin <RETURN>

to launch the Application User Interface.  If you did not set the path, you will have to include the 
full path to the CHEMKIN “bin” directory in front of the above command. 
 

An interface as shown in Figure 1 should appear on your screen.  Note:  this manual includes illustrations 
from the PC version only; the interface will look slightly different on other platforms.  However, the 
functionality is the same and the instructions provided here are the same for all computer systems.   
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Figure 1. Startup window for the CHEMKIN Application User Interface. 
 
From here you can choose an Application, as shown in Figure 2. 
 

Use the pull down menu 
or click on the Application 
button to start

Use the pull down menu 
or click on the Application 
button to start

 

Figure 2. Selecting an Application to run in the Application User Interface. 
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3.4.2 Running a Sample Problem 

For demonstration purposes, select the SPIN Application.  The SPIN Application Interface, shown in 
Figure 3, should appear on your screen.   
 
When CHEMKIN is first installed, the software is pre-set to start the user in a directory containing one of 
the sample problems for the chosen Application.    For SPIN, the “Input” and “Output” directory text 
boxes should be set to the location of the CHEMKIN sample called “rotating_disk_cvd”.   The names of the 
input and output files are also pre-set to the correct files in this sample directory.  You can “Edit” any of 
the input files to see their contents.   The pre-processors can be run separately by clicking on the 
individual “Chem”, “Surf” or “Tran” buttons, or you can run all of the needed preprocessors and the 
Application sequentially by clicking on the run “All” button. 

 

Figure 3. The SPIN Application User Interface 
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Figure 4. The SPIN Application User Interface with annotations 
 
Click the run “All” button now.   Messages that describe the progress of the executing programs should 
appear in the Message Box (See No. 6 in Figure 4).   If the CHEMKIN installation was successful and the 
License File has been installed correctly, the messages should report successful completion for the three 
pre-processors and the SPIN Application.   
 

Note for Windows:  On PCs, CHEMKIN 3.6 first creates MS-DOS prompt windows to run each of 
the CHEMKIN programs.  You will see this sequence of windows flash on the screen as programs 
execute.  These events are normal. 
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To view the results of the SPIN run, you may look at the output files using the “View” buttons (See No. 5 
in Figure 4).  You may also wish to view the results graphically.  The next section describes the use of the 
CHEMKIN Graphical Post-Processor. 
 

3.4.3 Launching the CHEMKIN Graphical Post-Processor 

From the Application User Interface, you can start the CHEMKIN Graphical Post-Processor by simply clicking 
on the “Post-Process” button (See No. 7 in Figure 4).    You can also launch the Graphical Post-Processor 
independently of the Application User Interface, as follows: 

Windows/PC:  Windows/PC:  Windows/PC:  Windows/PC:      

From the Windows desktop, go to:  Start → Programs → CHEMKIN Collection 3.6 and select 
“CHEMKIN Post-processor” to launch the Graphical Post-Processor. 

UNIX:  UNIX:  UNIX:  UNIX:      

If you set your “path” variable as instructed in Section 3.3.4, then you can open a UNIX shell and 
simply type: 

chemkin_post <RETURN>

to launch the Graphical Post-Processor.  If you did not add the CHEMKIN “bin” directory to your 
path, you will have to include the full path to that directory before “chemkin_post” in the 
above command. 

 
From the Application User Interface, click “Post-Process” now.  As the post-processor starts up, it will 
look for a solution file (save.bin) in the Output Directory indicated in the Application User Interface or 
in the user Preferences (see Section 6.4.1 for more information on setting Preferences).  (Note:  If a valid 
save.bin file is not found, a sample plot (sine/cosine) will be displayed.)  For the SPIN sample problem, 
the solution file includes both the solution data itself as well as sensitivity data for the gas-phase 
reactions, the surface reactions, and the heat-of-formation of species.   The Data Selection window, shown 
in Figure 5, allows you to select which solution components will be imported for plotting purposes.   
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1. Solution sets 
available for 
plotting

3. Selection of plot variables by value or by species name (√)

2. Species 
fraction or 
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filter options

4. Plot results

1. Solution sets 
available for 
plotting

3. Selection of plot variables by value or by species name (√)

2. Species 
fraction or 
sensitivity 
filter options

4. Plot results
 

Figure 5. Data Selection window for importing data from the SPIN sample into the 
Graphical Post-Processor. 

 
General Note:  Any time there is more than one solution “subset”, such as sensitivity data or 
multiple solutions, or when the number of variables in the solution exceeds 20, the program first 
provides the user with an opportunity to down-select the number of arrays that will be imported 
into the Graphical Post Processor, with the Data Selection window.  For smaller solution files, the 
program will go directly to the default plot. 

 
By default, all of the species data for the SPIN solution will be read into the Graphical Post-Processor.  
Click “OK” to read the current selections into the post-processor.  Figure 6 shows the default plot that 
you should now see on your screen.   
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Figure 6. Default plot generated by the Graphical Post-Processor for the SPIN sample. 
 
By default, the Graphical Post-Processor chooses the first two arrays to plot as “X” and “Y” in the initial 
plot.  The dependent variable (in this case “Distance”) is typically the first array.  To plot a different set of 
variables, use the “Plot” pull-down menu and choose “XY Plot”.  This will give you a menu of the 
available arrays, as shown in Figure 7.  To generate a new plot, leave the “X” variable the same, but select 
the other two velocity components from the list of available arrays, as shown in Figure 7. 
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Use the pull down menu to select 
X and Y variables for plotting 
Use the pull down menu to select 
X and Y variables for plotting 

 

Figure 7. X-Y Plot Selection menu for the SPIN sample in the Graphical Post-Processor 

 

You can now change the look of the plot by double-clicking on the X-axis, the Y-axis, the Plot Title, or 
the Legend, and adjusting the settings in the properties panels.   You can also drag-and-drop the Plot 
Title or the Legend for more optimal placement.  Figure 8 shows the results of changing some of the 
settings for the new velocity plot. 
 
This concludes the “Quick Start” instructions.  You can exit the program by choosing “Quit” from the 
“File” pull-down menu or by simply closing the window(s).  For more information on the CHEMKIN 
Collection or about Reaction Design, please see Chapters 4 and 5.  For more information on using the 
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CHEMKIN Application User Interface or the CHEMKIN Graphical Post-Processor, see Chapters 6 and 7, 
respectively.    If you would like to run CHEMKIN from the command line, rather than through the 
Application User Interface, you should refer to Chapter 8.  Chapter 9 provides information on available 
documentation, as well as on how to get help if anything has gone wrong in your installation, or if you 
are having difficulty running any of the programs.   
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Plot Title Plot Legend
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Plot Title Plot Legend
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Figure 8. Example plot generated in the Graphical Post-Processor, where the plot 
attributes have been modified from the default settings by double-clicking 
on the plot features (e.g. axis, legend, and title). 
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4. Introduction to the CHEMKIN Collection 

4.1 ABOUT REACTION DESIGN 

CHEMKIN Release 3.6 is part of Reaction Design’s continuing commitment to expanding the capabilities of 
the original system developed at Sandia National Laboratories.  In 1997, Sandia National Laboratories 
selected Reaction Design as the exclusive worldwide licensee for its CHEMKIN Collection.  Today under 
this agreement, Reaction Design provides support and new developments for hundreds of industrial and 
academic users worldwide. 
 
Reaction Design was founded in 1995 to provide software simulation and modeling tools to help process 
engineers create more efficient and environmentally friendly manufacturing processes.  The company is 
committed to the ongoing development of a comprehensive and easy-to-use set of software simulation 
tools that incorporate both chemical reaction and transport models.  Reaction Design engineers can also 
provide consulting services and software-based solutions to the customer's specific chemical process 
problems.  These software products and consulting services help industrial customers develop better 
products at a lower cost and with a smaller impact on the environment.  Reaction Design focuses its 
development, consulting and marketing efforts on four chemistry-intensive areas:  
 

Combustion:  Process heat and power generation, incinerators, jet and 
automotive engines, gas turbines and fuel design. 

Chemical Processing:  Chemical and pharmaceutical, oil refining, paper, high 
performance materials, corrosion and lubrication, food flavors and 
fragrances. 

Microelectronics:  Integrated circuit manufacturing, semiconductor processing 
equipment and reactive precursors, protective and optical coatings. 

Environment Protection:  Pollutant treatment and atmospheric chemistry. 

 
More information about Reaction Design products and services is available through our web site at the 
address:  www.ReactionDesign.com. 
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4.2 OVERVIEW OF CHEMKIN 

The CHEMKIN software architecture represents a modular approach that separates problem-specific 
information from problem-independent software. For a reacting flow simulation, Figure 9 illustrates this 
approach. The Application represents the general model description, independent of what chemical 
species are included in a specific problem. The general model description typically includes conservation 
equations for mass, momentum, energy, and species. The upper ovals in Figure 9 contain the input data 
that make the problem specific, i.e. species identity, species properties, reaction paths, and reaction rates. 
The CHEMKIN software utilities provide the interface between this problem-specific information and the 
problem-independent Application. The Application may itself be broken down into modules that 
perform different functions, such as residual evaluation, matrix manipulation, solution printing, or post-
processing. Additional problem-specific information that is non-chemical may also be input directly by 
the user, such as reactor pressure or inlet flow rate.  
 

Gas Phase Chemistry / Gas Phase Chemistry / Gas Phase Chemistry / Gas Phase Chemistry / 
Thermochemistry InputThermochemistry InputThermochemistry InputThermochemistry Input

Surface / Bulk PhaseSurface / Bulk PhaseSurface / Bulk PhaseSurface / Bulk Phase
Chemistry / ThermochemistryChemistry / ThermochemistryChemistry / ThermochemistryChemistry / Thermochemistry

InputInputInputInput

TransportTransportTransportTransport
PropertiesPropertiesPropertiesProperties

 Input Input Input Input

ApplicationApplicationApplicationApplication
 Input Input Input Input

CCCCHEMKIN HEMKIN HEMKIN HEMKIN 
ApplicationApplicationApplicationApplication

Post-processingPost-processingPost-processingPost-processing

CCCCHEMKIN HEMKIN HEMKIN HEMKIN 
Gas-Phase UtilitiesGas-Phase UtilitiesGas-Phase UtilitiesGas-Phase Utilities

SSSSURFACE URFACE URFACE URFACE CCCCHEMKIN HEMKIN HEMKIN HEMKIN 
UtilitiesUtilitiesUtilitiesUtilities

TTTTRANSPORTRANSPORTRANSPORTRANSPORT
UtilitiesUtilitiesUtilitiesUtilities

 

Figure 9. Illustration of the CHEMKIN modular approach to problem solving. 
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Included in the CHEMKIN distribution are sample problems for each Application, as well as detailed 
documentation describing each model.  In addition to the CHEMKIN Applications, described in Section 4.4, 
the CHEMKIN Collection includes Utilities that facilitate user development of modular application 
programs.  The Utilities are described in Section 4.3 below.  
 

4.3 THE CORE UTILITIES OF THE CHEMKIN COLLECTION 

The following are brief descriptions of the components of the Core Utilities included in the CHEMKIN 
Collection: 
 
CHEMKIN Pre-Processor (Interpreter) and Subroutine Library for the analysis of 

gas-phase chemical and plasma kinetics.  

SURFACE CHEMKIN Pre-Processor (Interpreter) and Subroutine Library for the analysis of 
heterogeneous chemical kinetics at gas-solid interfaces.  

Thermodynamic Database Compilation of polynomial fits to temperature for species enthalpy, 
specific heat, and entropy.  

TRANSPORT  Pre-processor and Subroutine Library for the evaluation of gas-phase, 
multi-component transport properties including diffusion coefficients, 
viscosities, and thermal conductivities of species and their mixtures.  

TRANSPORT Database  Compilation of molecular parameters used in the calculation of transport 
properties. 

TWOPNT  A module for solving two-point boundary-value problems using a 
modified Newton iteration method.  

EQUIL  A program for predicting the equilibrium state of systems containing 
ideal gas mixtures or ideal solutions of gases and liquids.  
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4.4 CHEMKIN APPLICATIONS  

The following are brief descriptions of the Applications available in the CHEMKIN Collection: 
 
AURORA  A program for predicting the time-dependent or steady-state properties 

of a well mixed or perfectly stirred reactor for thermal or plasma 
chemical systems.  AURORA allows inclusion of surface chemistry on 
multiple materials in the reactor and optionally performs time-
dependent sensitivity analysis of solution results.  

CRESLAF  A program for modeling laminar, chemically reacting, boundary-layer 
flow in cylindrical or planar channels. Surface chemistry on the inner 
walls of the channel may be included.  

OPPDIF  A program for modeling opposed-flow diffusion flames.  OPPDIF 
includes homogenous, gas-phase kinetics with sensitivity analysis. 

PLUG  A program for the analysis of plug-flow reactors with gas-phase and 
surface chemistry.  

PREMIX  A program for modeling steady, laminar, one-dimensional, pre-mixed 
flames. PREMIX includes homogenous, gas-phase kinetics with sensitivity 
analysis.  

SENKIN  A program for predicting the time-evolution of homogenous, gas-phase 
kinetics with sensitivity analysis.  

SHOCK  A program for predicting chemical behavior behind incident and 
reflected shock waves.  

SPIN  A program for modeling one-dimensional, rotating-disk or stagnation-
flow chemical-vapor-deposition reactors. SPIN includes homogenous gas-
phase and heterogeneous gas-surface kinetics with sensitivity analysis. 

SURFTHERM  A program for analyzing thermochemical and kinetic data in gas-surface 
chemical reaction mechanisms.  

There are several advantages of the modular approach to chemically reacting flow simulations. One is 
that a user may “mix and match” Applications and chemistry descriptions. Users who are interested in 
the determination of dominant reaction mechanisms, for example, are free from having to repeatedly 
develop computational tools with large systems of chemical reactions. The CHEMKIN input-file standard 
also facilitates communication and sharing of reaction sets between researchers. An analyst who must 
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perform calculations for several different chemical mixtures is free from concern over software 
programming. This also leads to more robust software that is applied to a wide variety of problems.  
 

4.5 CONTENTS OF THE CHEMKIN COLLECTION 3.6 PACKAGES 

CHEMKIN can be purchased in several different “packages” tailored to the needs of individual customers.  
The following is a brief description of the packages that are currently available:   
 

Full PackageFull PackageFull PackageFull Package    

Utility Set CHEMKIN Interpreter and Gas Phase Subroutine Library, SURFACE CHEMKIN 
Interpreter and Subroutine Library, Thermodynamic Database, TRANSPORT Pre-
processor and Database, TWOPNT, and EQUIL 

Applications AURORA, CRESLAF, OPPDIF, PLUG, PREMIX, SENKIN, SHOCK, SPIN, and 
SURFTHERM 

Chemistry PackageChemistry PackageChemistry PackageChemistry Package    

Utility Set (See above) 

Applications AURORA, CRESLAF, PLUG, SENKIN, and SURFTHERM 

Combustion PackCombustion PackCombustion PackCombustion Packageageageage    

Utility Set (See above) 

Applications AURORA, OPPDIF, PLUG, PREMIX, and SENKIN 

Microelectronics PackageMicroelectronics PackageMicroelectronics PackageMicroelectronics Package    

Utility Set (See above) 

Applications AURORA, CRESLAF, SPIN, SENKIN, and SURFTHERM 

Customer Designed PackagesCustomer Designed PackagesCustomer Designed PackagesCustomer Designed Packages    

Utility Set (See above) 

Applications Customer choice 
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4.6 HOW DOES CHEMKIN WORK? 

The CHEMKIN modular approach described in Section 4.2 provides a broad overview of the CHEMKIN 
philosophy. Here we describe more specifically how the CHEMKIN Collection provides the necessary 
interface between general Applications and chemistry-specific information. The flow chart in Figure 10 
illustrates components of the CHEMKIN software for a typical application. The major software components 
can be categorized as preprocessors, subroutine libraries, application models, and databases. The flow 
chart illustrates the communication between these components for a typical application model.  
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Figure 10. Schematic showing the relationship between the CHEMKIN Utilities and a 
CHEMKIN Application, including input and output files. 
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Pre-processors include the CHEMKIN Interpreter, the SURFACE CHEMKIN Interpreter, and the TRANSPORT 
Fitting Program. The pre-processors read information that is either supplied directly by the user, or is 
obtained from one of the CHEMKIN databases, or both. The user-input data tells the pre-processors what 
species to consider and what reactions can occur between these species. The pre-processors parse and 
interpret the user information, compile species property information from the databases, and calculate 
any additional chemistry-specific information that may be needed by the Application and that are 
appropriate to determine a priori. This information is then stored in ”Linking Files” that are later accessed 
by the CHEMKIN Subroutine Libraries when called by the Application. The CHEMKIN Interpreter must 
always precede the other pre-processors as it provides information that is used by the others through its 
Linking File.  
 
Subroutine libraries include the CHEMKIN Gas-phase Library, the SURFACE CHEMKIN Library, and the 
TRANSPORT Library. Each of these libraries includes an initialization routine that reads the information in 
the Linking File, stores the information in arrays and returns these storage arrays to the Application for 
use in subsequent calls to other library routines. The CHEMKIN Gas-phase Library contains routines that 
provide information about the size of the chemistry set; information about the elements, species, and 
reactions; values of physical constants; equation-of-state calculations and units conversions; 
thermodynamic properties; calculations of chemical production rates; and reaction equilibrium constants. 
The SURFACE CHEMKIN Library contains routines that perform similar functions for the surface chemistry 
set. The TRANSPORT Library contains routines that evaluate gas-phase species and gas-mixture transport 
properties including ordinary diffusion coefficients, thermal diffusion coefficients, thermal conductivities, 
and viscosities. The transport properties can be evaluated using either mixture-averaged or 
multicomponent formulations.  
 
Currently, the CHEMKIN Collection includes databases of fundamental species data for calculation of 
transport and thermodynamics properties.  Details on the species data available can be found in the 
Thermodynamic Data and TRANSPORT manuals.  Users may also augment or replace database entries by 
providing their own sets of data.  
 
We have compiled a list of journal articles and other publications that have referenced CHEMKIN 
Collection software since 1985. These citations may be useful in discovering how other people are using 
the CHEMKIN Collection in research and industrial applications.   The citation bibliography is included on 
our website (www.ReactionDesign.com) and is updated periodically. 
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5. Problem Solving with the CHEMKIN Collection 

5.1 HOW TO USE  CHEMKIN 3.6 TO SOLVE CHEMICAL MODELING PROBLEMS 

The CHEMKIN software can be used in several different ways, depending on your own areas of expertise 
and your modeling needs. The most straightforward way to use the CHEMKIN software is by direct 
application of the models included in the CHEMKIN Collection. A brief summary of the Applications is 
shown in Table 1. 
 
 

TableTableTableTable    1  1  1  1  CCCCHEMKINHEMKINHEMKINHEMKIN Applications Applications Applications Applications    

ApplicationApplicationApplicationApplication    Brief Description of the Brief Description of the Brief Description of the Brief Description of the CCCCHEMKINHEMKINHEMKINHEMKIN Application Application Application Application    

AURORA Well stirred thermal and plasma reactors with gas and surface reactions. 
CRESLAF Laminar, boundary layer flows in cylindrical or planar channels 
EQUIL Chemical equilibrium of an ideal gas or solution mixture 
OPPDIF Diffusion flame between two opposing nozzles 
PLUG Plug flow reactor with gas and surface chemistry 
PREMIX Steady, laminar one-dimensional pre-mixed flames 
SENKIN Sensitivity analysis of homogeneous gas-phase kinetics 
SHOCK Chemical dynamics behind incident and reflected shock waves 
SPIN Rotating-disk/stagnation flow chemical vapor deposition reactors 
SURFTHERM Analysis of thermochemical and kinetic data in gas-surface reaction mechanisms 
 
 
 
Additional applications can be built using the sub-components or utilities of the CHEMKIN Collection. This 
mode requires a much higher level of modeling expertise, but offers more flexibility in describing a 
specific system of interest to you. Table 2 presents a brief description of the utilities 
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TableTableTableTable    2222  CCCCHEMKINHEMKINHEMKINHEMKIN Utilities and Supporting Databases Utilities and Supporting Databases Utilities and Supporting Databases Utilities and Supporting Databases    

CCCCHEMKINHEMKINHEMKINHEMKIN Utility/Database Utility/Database Utility/Database Utility/Database    Brief Description of the Brief Description of the Brief Description of the Brief Description of the CCCCHEMKINHEMKINHEMKINHEMKIN Utility/Database Utility/Database Utility/Database Utility/Database    

CHEMKIN Library of analysis tools for gas-phase chemical and plasma kinetics 
SURFACE CHEMKIN Library of analysis tools for chemical kinetics at gas-solid interfaces 
Thermodynamic Property 
Database 

Temperature variation of species enthalpy, specific heat, and entropy 

TRANSPORT Library of tools for evaluation of multi-component transport properties  
TRANSPORT  Property Database Molecular properties used in calculating transport properties 
TWOPNT Algorithms for solution of two-point boundary value problems 
 
 
 
Each of the Application and Utility manuals describe in much more details how to build or extend the 
capabilities of the existing programs.  
 

5.2 STEPS IN USING CHEMKIN 3.6 

There are six basic steps involved in using CHEMKIN to solve a typical chemical process modeling 
problem. Depending on the particular Application, some of the steps are not required; these are indicated 
by ( ) around the step. 
 

1. Prepare the chemistry input file(s) 

Gas-phase chemistry 

(Surface chemistry) 

2. Assemble the thermodynamic and transport databases 

Gas-phase thermodynamics 

(Surface thermodynamics) 

(Gas-phase species transport data) 
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3. Prepare the Application-specific input data  

(Geometry) 

(Process conditions) 

(Solution method options) 

4. Run the Pre-Processing programs  

Chem  –  The CHEMKIN gas-phase reaction mechanism interpreter 

(Tran)  –  The TRANSPORT property fitting program 

(Surf)  –  The SURFACE CHEMKIN reaction mechanism interpreter 

5. Run the Application  

6. Post-process the results 

 
Table 3 summarizes the input data requirements for each of the CHEMKIN Applications. The specific 
details of the data formats, and information needs are described in the user manuals for the Applications 
and the CHEMKIN Utilities. 
 

TableTableTableTable    3  Summary of Input Needed for 3  Summary of Input Needed for 3  Summary of Input Needed for 3  Summary of Input Needed for CCCCHEMKINHEMKINHEMKINHEMKIN Applications Applications Applications Applications    

    
    

ApplicationApplicationApplicationApplication    

    
GasGasGasGas----phasephasephasephase    
ChemistryChemistryChemistryChemistry    

    
Surface Surface Surface Surface 

ChemistryChemistryChemistryChemistry    

    
ApplicationApplicationApplicationApplication----    

specific Inputspecific Inputspecific Inputspecific Input    

    
ThermodThermodThermodThermodynamic ynamic ynamic ynamic 

DatabaseDatabaseDatabaseDatabase    

Transport Transport Transport Transport 
Properties Properties Properties Properties 
DatabaseDatabaseDatabaseDatabase    

AURORA ✔  (✔ ) ✔  ✔   
CRESLAF ✔  ✔  ✔  ✔  ✔  
EQUIL ✔  (✔ ) ✔  ✔   
OPPDIF ✔   ✔  ✔  ✔  
PLUG ✔  ✔  ✔  ✔   
PREMIX ✔   ✔  ✔  ✔  
SHOCK ✔   ✔  ✔   
SENKIN ✔   ✔  ✔   
SPIN ✔  ✔  ✔  ✔  ✔  
SURFTHERM ✔  ✔  ✔  ✔  (✔ ) 

 
An illustration of some of the steps is presented in Figure 11 
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1. CHEMKIN 3.6 
Startup Panel

2. Application Panel
3. Chemistry Input Data

4. Application-
specific 
Input 
Parameters

5. CHEMKIN 
Graphical Post-
processor

1. CHEMKIN 3.6 
Startup Panel

2. Application Panel
3. Chemistry Input Data

4. Application-
specific 
Input 
Parameters

5. CHEMKIN 
Graphical Post-
processor

 
Figure 11. A schematic representation of the information flow in running a typical 

CHEMKIN Application. 
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5.3 WHERE TO GET THE NEEDED INPUT DATA? 

A typical question is, “I can't find data for certain species in the Thermodynamic or Transport database. 
What should I do?”  First, check the complete species list in the Thermodynamic Database and Transport 
manuals.  These data were originally supplied to Reaction Design by Sandia.  While the original data has 
not been officially updated, Reaction Design continues to assemble information for additional species that 
will be added to future releases.  If you are unable to locate certain species in the Thermodynamic or 
Transport databases there are several other sources for developing the needed information including: 
 

1. Original Sources: These are organizations that generate or critically evaluate data.  One of the 
most important is the National Institute of Standards and Technology (NIST). 

2. Secondary and Tertiary Sources: These are compilations of data from original sources and are 
often published in handbooks and journals. For chemical kinetics a good starting point is the 
J. Physical and Chemical Reference Data. 

3. Physical Property Estimation Methods: These are methods that can be used to evaluate thermo-
physical property information.  A classical example is the book by Benson (1976) 
Thermochemical Kinetics: Methods for the Estimation of Thermochemical Data and Rate Parameters, 
Second Edition, John Wiley & Sons, Inc., New York. 

4. Web Sites: The Reaction Design web site contains links to many different sources of 
thermochemical and transport property information. 

Many other sources of data are described in Maizell (1998), How to Find Chemical Information: A guide for 
Practicing Chemists, Educators and Students, John Wiley & Sons, Inc., New York. 
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6. The CHEMKIN Application User Interface  

This Section provides a more complete description of the elements of the CHEMKIN Application User 
Interface.  The information here includes descriptions of menus and buttons as well as quick reference 
“Hints” on program features.  We recommend that you first read through Section 3.4 so that you are 
familiar with starting the Application User Interface and you are sure that your software is installed 
correctly.    
 

6.1 SELECTING INPUT AND OUTPUT FILES 

The Application User Interface is designed to help you organize your input and output files, and to 
remind you of the steps and input data required to run each Application.   For an illustration of the 
Application User Interface features, see Figure 4 in Chapter 3.  These features are described in more detail 
here. 

DirectoriesDirectoriesDirectoriesDirectories    

You should first set the working directories where you will store the input and output files.  By default, 
the program assumes that the output directory is the same as the Input Directory.  
 
To select a new directory, you can either type the path to the directory in the text box, or click “Browse” 
to use the mouse to select the desired directory using your computer’s file browser.   
 

Hints: 

• The directory must already exist. 

• You can make the Output Directory independent of the Input Directory by modifying the 
user Preferences (Choose “Preferences” from  the “File” pull-down menu). 

• You can change the default directory that the program assumes at startup in the user 
Preferences (Choose “Preferences” from  the “File” pull-down menu). 

Input File NamesInput File NamesInput File NamesInput File Names    

The input files that are used by the pre-processors and the Application must reside in the Input Directory.  
By default, the program will suggest filenames in the text boxes.  To select a different filename, you can 
either type the new name in the text box or click “Browse” to select a new file.   You can also click on  
“Edit” to modify the selected file or to create a new file. 
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Hints: 

• Since the text box is small on some platforms, using the “Browse” button may be more 
reliable than typing to ensure that you have the correct input file selected. 

• You may change the default editor invoked by the “Edit” buttons by modifying the user 
Preferences (Choose “Preferences” from  the “File” pull-down menu). 

• Remember:  your input files must exist in the specified Input Directory. 

Output File NamesOutput File NamesOutput File NamesOutput File Names    

The Pre-processors and the Application program will create output files in the specified Output 
Directory.  By default, this is the same directory as the Input Directory.  Also by default, the Application 
User Interface will suggest filenames in the text boxes.  To select a different filename, you can either type 
the new name in the text box or  click “Browse” to select a new file.   Once you have clicked on “Browse” 
you may still need to type in the filename, since this file typically does not yet exist.  If you choose an 
existing file, the file will be overwritten when the program is run.  After the programs have been run, 
you can view the output files by clicking on their “View” button.  
 

Hints: 

• Since the text box is small on some platforms, using the “Browse” button may be more 
reliable than typing to ensure that you have the correct output filename entered. 

• You may change the default editor invoked by the “View” buttons by modifying the user 
Preferences (Choose “Preferences” from the “File” pull-down menu). 

• Remember:  the output files will always be created in the specified Output Directory. 

Database FilesDatabase FilesDatabase FilesDatabase Files    

Unlike the Input and Output Files, the Database Files are specified by providing the full directory path to 
the required files.  These files typically will not reside in the Input Directory or the Output Directory, 
although it is OK if the directory paths happen to be the same.   By default, the database files selected are 
the standard Thermodynamic Database file and the Transport Database file distributed with CHEMKIN.  
To change to a different file, click “Browse” and navigate to the desired file.   You can also click on  
“View” to open the selected file in an editor. 
 

Hints: 

If the Transport Database is not required for a specific Application, then the selection features 
will become inactive. 
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6.2 RUNNING THE PROGRAMS 

As described in Chapter 5, solving a problem using CHEMKIN requires running one or more pre-
processors as well as running the Application program itself. The right-hand column of the Application 
User Interface allows you to run these programs one at a time or, alternatively, to run all needed pre-
processors and the Application by clicking the run “All” button. In general, the order in which the pre-
processors is run is important:  all required pre-processors must be run before the Application, and the 
“Chem” pre-processor should always be run first.  The two options are described in more detail below. 

Run “Chem” Run “Chem” Run “Chem” Run “Chem”     

The “Chem” button runs the CHEMKIN Interpreter using the specified gas-phase chemistry input file, as 
well as the Thermodynamic Database File.   The CHEMKIN Interpreter creates a Linking File that is 
required by the other pre-processors and by the Application.  For more information about the CHEMKIN 
Interpreter program and input, refer to the CHEMKIN user manual. 

Run “Surf” Run “Surf” Run “Surf” Run “Surf”     

The “Surf” button runs the SURFACE CHEMKIN Interpreter using the specified surface chemistry input file, 
as well as the Thermodynamic Database File.   The SURFACE CHEMKIN Interpreter creates a Linking File 
that is required by the Application.  For more information about the SURFACE CHEMKIN Interpreter 
program and input, refer to the SURFACE CHEMKIN user manual. 

Run “Tran” Run “Tran” Run “Tran” Run “Tran”     

The “Tran” button runs the TRANSPORT Fitting Routine using the specified Transport Database File.   The 
TRANSPORT program creates a Linking File that is required by the Application.  For more information 
about the TRANSPORT program and input, refer to the TRANSPORT user manual. 

Run the ApplicationRun the ApplicationRun the ApplicationRun the Application    

Each Application User Interface panel has a button labeled with the Application name and aligned with 
the Application Input and Output File selection features.  This Application button runs the Application 
program using the specified Input File.  The Application will create (or overwrite) the Output File. In 
addition to the text Output File, all of the Applications (except for SURFTHERM) generate a binary solution 
file named save.bin.  The save.bin file is read by the Graphical Post-Processor to plot the solution 
results, as described briefly in Chapter 3 and in more detail in Chapter 7.  

Running “All”Running “All”Running “All”Running “All”    

The “All” button automatically runs the required sequence of pre-processors and then runs the 
Application, as described by the individual buttons above. 
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Hints: 

When running Chem and Surf, the program will create a local copy of the Thermodynamic 
Database File in the Output Directory, and rename the file “therm.dat”.  If there is already a 
therm.dat file in that directory, you will be prompted whether or not to overwrite the existing 
file. Similarly, running Tran will try to create a local tran.dat file, and will prompt you for a 
response if an existing file is found.  You can allow the program to always overwrite the 
therm.dat and tran.dat files found in the Output Directory, by modifying your user 
Preferences. (Choose “Preferences” from the “File” pull-down menu). 

 

6.3 INFORMATIONAL MESSAGES AND ERROR REPORTS 

The Message BoxThe Message BoxThe Message BoxThe Message Box    

The Message Box, located at the bottom of the Application User Interface panel, helps you to follow the 
progress of your work.  The messages tell you what command is being executed, when it has finished 
executing, and whether or not the process has completed successfully.  

Error, Warning and Information DialogsError, Warning and Information DialogsError, Warning and Information DialogsError, Warning and Information Dialogs    

In addition to the advisory messages in the Message Box, you may also see pop-up Information, Warning, 
or Error Dialog boxes.  These Dialogs inform you that some operation did not complete properly, that 
you need to make a choice between one or more options, or that an operation about to occur may result in 
some unwanted effects (such as overwriting files).  The message may also provide some suggested action 
that you can undertake to correct or avoid the problem.  In order to continue working, you must click on 
a button in the box (“OK”, “Yes”, “No”, etc.).   
 

6.4 THE “FILE” MENU 

The “File” pull-down menu is located at the left-hand end of the menu bar on the Application User 
Interface.  There are four options available under this menu in Release 3.6:  “Save Session”, 
“Recover Session”, “Preferences” and “Quit”.  The “Quit” option simply exits the CHEMKIN Application 
User Interface.  The other three options are discussed further below.  Figure 12 demonstrates the selection 
of “Preferences” from the “File” menu.   
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Figure 12. Selection of Preferences from the File pull-down menu. 
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6.4.1 Preferences 

The Preferences option provides you with some control over the settings for the CHEMKIN Application User 
Interface, as well as the settings for the CHEMKIN Graphical Post-Processor.   The Preferences selection panel 
is shown in Figure 13.   
 
Note:  For a few of the preference options, you will need to restart the CHEMKIN Application User Interface or the 
CHEMKIN Graphical Post-Processor before the changes take effect.   
 

Hints: 

If the path to the directory containing your Editor program is contained in your environment 
“path”, then only the edit command must be entered in the Preferences Editor box (for example, 
“wordpad” on Windows).  If not, then you must include the full directory path to the editor 
program for the editor command to work properly (for example, “c:\Program
Files\Accessories\wordpad”).  

 

6.4.2 Saving and Restoring Sessions 

Once you have set up a problem in the Applications User Interface panel, you can save your directory, 
filename, and database settings using the “Save Session” option in the “File” menu.  A dialog will 
prompt you for a filename and a directory location for the Session File.   
 
A previous session’s settings can be recovered by selecting the “Recover Session” option in the “File” 
menu.   A file browser allows you to select the previously created Session File.  
 
By default, you will be prompted to save a session file every time you quit the Application User Interface, 
or when you change from one Application to another.  This prompting can be disabled in the Preferences 
menu. 
 

Hint: 

When you recover a Session File, you should be in the same Application User Interface panel (e.g. 
SPIN), as you were when you created the Session File.  
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Figure 13. The Preferences selection panel for the Application User Interface and for 
the Graphical Post-Processor 
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7. The CHEMKIN Graphical Post-Processor 

This Section provides a more complete description of the elements of the CHEMKIN Graphical Post-
Processor.  The information here includes descriptions of menus and buttons as well as quick reference 
“Hints” on program features.  We recommend that you first read through Section 3.4 so that you are 
familiar with starting the Graphical Post-Processor and you are sure that your software is installed 
correctly.    
 

7.1 THE “FILE” PULL-DOWN MENU 

The “File” pull-down menu is located at the left-hand end of the menu bar that runs across the top of the 
Graphical Post-Processor window. There are six operations available in CHEMKIN Release 3.6:  “Open”, 
“Print”, “Import”, “Export”, “Preferences” and “Quit”.  The “Quit” option simply exits the Graphical 
Post-Processor.  The other five options are discussed below. 
 

7.1.1 Open 

The “Open” option allows you to open a new CHEMKIN binary solution file, which the program expects 
to have a “.bin” suffix.  Selecting the “Open” option puts you in a file browser on your computer, where 
you can choose an existing binary solution file.  Once the file is selected, the program will attempt to read 
the data on the file.  If there are any difficulties reading the file, a message will appear in the Message Box 
at the bottom of the Graphical Post-Processor window. 
 
As described in Section 3.4, when you open a new binary solution file, the program will either open a 
Data Selection window, or will directly create a default plot from the data that was read.  The Data 
Selection window is opened whenever there are more than 20 variables in the solution or when there is 
more than one solution sub-set. 
 

Hints:  

When reading in a new save.bin file, you will be prompted to keep or clear existing data sets in 
the Graphical Post-Processor.  Keeping more than one solution data set open in the Post-
processor allows you to plot one solution against another. 
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7.1.2 Import 

You can import x-y data from plain text files into the Graphical Post-Processor using the “Import” option 
in the “File” menu.  The import utility expects to find columns of data, delimited by tabs, commas, or 
spaces.  Selecting the “Import” option opens a dialog box where you can choose the delimiter for the 
columns in the file, the number of header lines to skip before reading the data, and whether or not to read 
the first line (after the skipped lines) as character-string labels for the columns.   If your selections do not 
appear  to agree with the format of the first couple of lines of data in the file, you will receive an warning  
message.  If you click “OK” to read the data in and the import utility encounters errors reading the 
specified format, you will receive a message in the Message Box, and the data will not be imported.  If the 
format is read correctly, the first two columns found in the file will be used to create a default plot. 
 

7.1.3 Export 

To give you more flexibility in analyzing and post-processing your data, you can export all of the data 
arrays currently stored in the Graphical Post-Processor into a file of text columns.  The columns in the 
exported text files may be delimited by tabs, commas, or spaces.  Such formats can be easily imported 
into spreadsheet programs, as well as other visualization and analysis software.    When you select the 
“Export” option from the “File” menu, you will be asked to choose the delimiter for the exported data 
columns, and then the name and location of the  data file that will be written.    If there are any errors 
writing the file, a message will appear in the Message Box at the bottom of the Graphical Post-Processor 
window. 
 

7.1.4 Print 

Any plot generated on your screen can be printed to a color or black-and-white printer using the “Print” 
utility.  This requires that you already have a print driver installed and a default printer set on your 
computer.  You can also print to a Postscript file, by selecting the file option on the printer dialog.   
 

7.1.5 Preferences 

As described in Chapter 6, Section 6.4.1, the “Preferences” option provides you with some control over 
the settings for the CHEMKIN Application User Interface, as well as the settings for the CHEMKIN Graphical 
Post-Processor.  The main setting for the CHEMKIN Graphical Post-Processor is a choice of whether the 
species composition data are imported from CHEMKIN solution files as mole fractions or mass fractions.  
The default is to convert the data to mole fractions.  Note: if you change the settings in the Preferences 
dialog, you will need to restart the CHEMKIN Graphical Post-Processor before the changes take effect. 
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7.2 THE “VIEW” PULL-DOWN MENU 

Two options are available from the “View” pull-down menu, “Show/Hide Legend” and “Show/Hide 
Title”.  These options allow you show the Plot Title or Legend, if you have previously selected to “Hide” 
them in the Plot Title or Legend Attributes Dialog.  Alternatively, if you have previously selected to 
“Show” the Plot Title or Legend (the default), you can use the “View” menu to “Hide” these items. 
 

7.3 THE “PLOT” PULL-DOWN MENU 

Although we plan to have more plot options in future CHEMKIN releases, the current release only allows 
creation of X-Y plots.  Choosing the “X-Y Plot” option in the “Plot” menu opens a window from which 
you can select the data arrays to plot as “X” (horizontal axis) or “Y” (vertical axis) variables in the 
Graphical Post-Processor.   
 

7.4 CHANGING PLOT ATTRIBUTES 

By using your mouse to double-click or click-and-drag items in the plot window, you can change the 
appearance of the plot as displayed in the Graphical Post-Processor.  Table 4 summarizes what items can 
be accessed by the mouse and what attributes can be changed. 



Introduction to the CHEMKIN Graphical Post-Processor 
 

 
56

    

TableTableTableTable    4  Plot Attributes That Can Be Changed4  Plot Attributes That Can Be Changed4  Plot Attributes That Can Be Changed4  Plot Attributes That Can Be Changed    

ItemItemItemItem    Mouse ActionMouse ActionMouse ActionMouse Action    AttributesAttributesAttributesAttributes    

X-Axis / Y-Axis double-click Axis Label Text 
Axis Label Font and Font Size 
Linear/Log Axis Scaling 
Axis Minimum/Maximum values 
Tick Direction, Number, and Size 

Plot Title double-click Title Text 
Font and Font Size 

Plot Title click-and-drag Title Position on Plot 
Legend double-click Hide/Show Legend 

Hide/Show Outline 
Hide/Show Legend Title 
Legend Title Text 
Legend Title Font and Font Size 
Legend Item Labels 
Legend Item Font and Font Size 

Legend click-and-drag Legend Position on Plot 
 

7.5 PLOTTING SOLUTIONS AGAINST EXTERNAL DATA OR OTHER SOLUTIONS 

A new feature of CHEMKIN Release 3.6 is the ability to import more than one solution set at one time into 
the CHEMKIN Graphical Post-processor.  To demonstrate this feature, let’s assume that we have some 
experimental temperature data that we want to compare to the temperature profile calculated in the 
“freely propagating flame” sample problem for PREMIX.  The procedure below describes how to import 
data and compare to a Chemkin Application solution.  The same procedure can be used to plot one 
solution against another, except in that case we would use “Open” from the file menu instead of 
“Import” to obtain the second data set. 

TemperaturTemperaturTemperaturTemperature Data for Comparison:e Data for Comparison:e Data for Comparison:e Data for Comparison:    

First, you will need to save the “experimental” data in a text file format that can be imported into the 
CHEMKIN Graphical Post-processor.  Example contents of a (fictitious) data file are shown below: 
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MyDistance_cm,MyTemperature_K

0,300

0.1,1700

0.2,2030

0.25,2150

0.3,2200

0.5,2250

0.75,2290

1.5,2300

3,2320

4,2350

8,2100

To follow along with this example, the above data needs to be saved in a file named “mydata.csv,” in the 
PREMIX “freely propagating flame” sample directory. 

Run thRun thRun thRun the e e e PPPPREMIXREMIXREMIXREMIX Sample Problem Sample Problem Sample Problem Sample Problem    

Next, run the “freely_propagating_flame” sample problem, which is located in a subfolder of the samples 
“premix” directory.  Follow the same approach as described in Section 3.4.2 for the SPIN sample.  When 
the PREMIX Application has run successfully, launch the Graphical Post-Processor.  Select 
“SOLUTION_3_VS_DISTANCE” in the Data Select panel, to select the last, most-refined solution.  The 
default plot will be Temperature vs. Distance. 

Plot Imported DaPlot Imported DaPlot Imported DaPlot Imported Data Against a Solution in the Graphical Postta Against a Solution in the Graphical Postta Against a Solution in the Graphical Postta Against a Solution in the Graphical Post----ProcessorProcessorProcessorProcessor    

With the temperature plot displaying in the Graphical Post-Processor, select “Import” from the File 
menu.  You will first see the “Keep or Clear” dialog window shown in Figure 14.  Click on the “Premix 
Solution Data” to indicate that you want to keep this set (or click on the “KEEP ALL” button) and “OK”.  
Then, browse to the “mydata.csv” text file.  In the Import dialog box, select “Comma” as the delimiter 
and check the “Read column titles” box, and click “OK”.  The default plot that appears will be a plot 
from the imported data only.  Now, go to the Plot→→→→XY-Plot menu.  You will next see a window that 
shows both the PREMIX Solution and the Imported Data Sets.  For each, click on the “Select XY” button 
and make select Temperature for “Y” and Distance for “X”, as shown in Figure 15.  The result is shown in 
Figure 16, after modifying the plot attributes. 
 



Introduction to the CHEMKIN Graphical Post-Processor 
 

 
58

1. Choose Import 
from File menu

2. Opt to Keep the 
existing solution

3. Open file 
with 
external 
data

4. Import 
comma-
delimited 
values

1. Choose Import 
from File menu

2. Opt to Keep the 
existing solution

3. Open file 
with 
external 
data

4. Import 
comma-
delimited 
values

 

Figure 14. Importing external data to plot against CHEMKIN solution results.  Note: 
the File browser will look different on different platforms. 
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1. Plot menu

3. XY-Plot 
Selection 
for PREMIX 
Solution

2.XY-Plot 
Selection for 
Imported 
Data

1. Plot menu

3. XY-Plot 
Selection 
for PREMIX 
Solution

2.XY-Plot 
Selection for 
Imported 
Data

Figure 15. Selection of plot variables for multiple data sets displayed in same plot. 
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Figure 16. Comparison Plot of PREMIX Solution and Imported Data. 
 

7.6 UNITS OF SOLUTION VARIABLES  

The binary solution files (save.bin) produced by the CHEMKIN Applications include values for solution 
variables, (e.g. velocities, temperatures, pressure, and species fractions), which have physical units (e.g. 
[cm/s], [K], [dyne/cm2], and mole fractions).    In some cases, the variable names assigned to the arrays 
indicate the units (e.g. a variable labeled “Pressure_In_Torr” would indicate that the date has the units of 
Torr instead of the default).  In all other cases, you can assume that the units are the standard units for the 
“cgs” system (centimeters, grams, seconds).  Table 5 below indicates the cgs units for some of the 
common solution variables: 
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TableTableTableTable    5  CGS Units for Common Solution Variables5  CGS Units for Common Solution Variables5  CGS Units for Common Solution Variables5  CGS Units for Common Solution Variables    

VariableVariableVariableVariable    CGS UnitsCGS UnitsCGS UnitsCGS Units    

Time s 
Distance  cm 
Velocity cm/s 
Area cm2 
Pressure dyne/cm2 
Density g/cm3 
Temperature K 
Mass flow rate g/s 
Volume flow rate cm3/s 
Deposition/Etch Rate mole/cm2-s 
Molecular weight g/mole 
Species Fraction Determined by user Preferences  

(see Section 7.1.5) 
 
 
 
For variables not listed in Table 5, see the specific Application user manual for information about units of 
variables. 
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8. Using CHEMKIN from the Command Line  

We recognize that there will always be some users who prefer to run CHEMKIN by typing commands from 
a command line (in a MS-DOS prompt or a UNIX shell, for example), rather than using the CHEMKIN 
Application User Interface.  Also, if you are writing your own applications or your own post-processing 
routines, you will need to be familiar with running CHEMKIN from a command line.  This section 
describes the steps for running a sample problem, the makefiles and build scripts available in the 
CHEMKIN distribution, as well as the FORTRAN post-processors that are available as templates for writing 
your own post-processing routines.  For most uses of command-line programming, you will need to have 
a FORTRAN compiler installed on your platform.  For Windows/PC users, the required compiler is Digital 
Visual Fortran version 5.0D or later. 
 

Note for Windows:  To open an MS-DOS prompt in Windows, go to your Start menu, select 
Programs, and then select MS-DOS Prompt (Windows) or Command Prompt (Windows NT) 

 

8.1 RUNNING THE CHEMKIN SAMPLE PROBLEMS 

The CHEMKIN distribution includes one or more sample problems for each Application.  Generally, each 
sample consists of a set of input files, a “make” file that builds and runs the sample, and an HTML file 
that describes what type of problem the sample demonstrates.  For the purposes of describing the 
commands in this section, we will refer to the root of the CHEMKIN installation as c:\chemkin36 for PCs 
and ~/chemkin36 for UNIX.  If you changed the default location during installation, you will need to 
substitute the actual path where CHEMKIN is installed in place of these references.  
 

8.1.1 Build All Samples 

To build and run all the samples in the release, change directories to the samples subdirectory of the 
CHEMKIN installation (c:\chemkin36\samples for PCs or ~/chemkin36/samples for UNIX) and 
type: 
 

buildsamples
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Note for UNIX:  On UNIX, you may not have the current directory (.) in your “path”. If typing 
buildsamples does not work in your UNIX shell, try prefixing the command with your current 
directory, like this:  

./buildsamples

 
This command will launch a batch script that will build and run all of the samples by changing into each 
sample directory in turn and running the make file found there.   Under the samples directory, there are 
subdirectories named for each Application. Within these subdirectories, there are different sample 
problems, such as “gas_psr” or “rotating_disk_cvd”, depending on the Application.  Within these 
sample-problem directories, you can look at the sample input and output files with a standard text editor.  
 

8.1.2 Clean All Samples 

You can undo the buildsamples command by running cleansamples in the same manner as 
described in Section 8.1.1.  This command removes all of the output and intermediate files from the 
sample sub-directories.   
 

General Note:  It is often desirable to run cleansamples to reduce the use of disk space. 

 

8.1.3 Using the Make files 

As mentioned above, each of the sample sub-directories contains a “make” file that will compile and link 
programs if necessary, run pre-processors, run the Application, and run a command-line post-processor if 
required.  The make files obtain information about the build dependencies and machine-specific 
commands from files located in the “include” directory in the root of the CHEMKIN installation 
(c:\chemkin36\include for PCs or ~/chemkin36/include for UNIX).  The include file is named 
chemkin_make_pc.inc on the PC and chemkin_make_unix.inc on UNIX.   
 

General Note:  The make files are designed to be used in the directory level where they are 
located, since they determine the location of the Include File relative to this directory.  If you 
want to copy a makefile to another directory for your own use, you may need to modify the 
makefile before it will work properly in its new location.  

 
As an example, we will demonstrate here how to run the AURORA sample problem called “gas_psr”.  
First, change directories to the AURORA gas_psr sample directory and then run the “make” utility as 
follows: 
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Windows/PC:  Windows/PC:  Windows/PC:  Windows/PC:      

cd c:\chemkin36\samples\aurora\gas_psr

nmake –f gas_psr_pc.mak > gas_psr_pc.log 

UNIX:  UNIX:  UNIX:  UNIX:      

cd ~/chemkin36/samples/aurora/gas_psr

make –f gas_psr_unix.mak > gas_psr_unix.log 

Note that the results of the make utility are redirected to a log file so that you can review any warnings or 
error messages that occur during the build process.    
 

Notes for Windows:   

• Notice that the “make” utility on the PC is called nmake instead of make 

• You must have Digital Visual Fortran installed on your PC for the nmake command to be 
recognized. 

 

8.1.4 Running Step by Step 

In case you prefer not to use the makefiles provided or you want to build your own scripts, this section 
describes how to run each command directly on the command line.  Here we will repeat the above 
example, but show the commands that you will need to type to the terminal for each step.   
 

General Note:  For all of the CHEMKIN pre-processors and Applications, all input and output files 
can now be specified using command-line arguments (e.g. “-i “ precedes an input file name).  A 
complete list of the command-line argument options is given in Section 8.1.5. 

 

1. Change directories to the AURORA gas_psr  sample directory: 

Windows/PC:Windows/PC:Windows/PC:Windows/PC:   

cd c:\chemkin36\samples\aurora\gas_psr

UNIXUNIXUNIXUNIX::::  

cd ~/chemkin36/samples/aurora/gas_psr
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2. Run the CHEMKIN Intrepreter: 

Windows/PC:Windows/PC:Windows/PC:Windows/PC: 

..\..\..\bin\chem -i chem.inp -o chem.out –d c:\chemkin36\data\therm.dat

UNIXUNIXUNIXUNIX::::  
../../../bin/chem -i chem.inp -o chem.out –d ~/chemkin36/data/therm.dat

Here, the command-line argument “-i” precedes the name of the gas-phase chemistry input file, 
while the command-line argument “-o” precedes the diagnostic output file name.  The location of the 
thermodynamics database file is given by “-d”.  In addition to the chem.out file, the CHEMKIN 

Interpreter creates an output file named chem.asc.  In this example, the Linking File will be created 
by default in the local directory.  The Linking File is required by other CHEMKIN pre-processors and 
by the Application. You should always check for errors by reviewing the contents of chem.out, before 
proceeding.  

 
General Note:  For Applications that require TRANSPORT data (not required by AURORA) or 
SURFACE CHEMKIN (optional input for AURORA), you will also need to run the TRANSPORT and 
SURFACE CHEMKIN pre-processors.  These additional pre-processors must be run after the 
CHEMKIN Interpreter and before the Application.   

3. Run the Application, in this case the AURORA program: 

Windows/PC:Windows/PC:Windows/PC:Windows/PC: 

..\..\..\bin\aurora -i aurora.inp -o aurora.out –b save.bin

UNIXUNIXUNIXUNIX::::  
../../../bin/aurora -i aurora.inp -o aurora.out –b save.bin

In addition to the aurora.out file, the AURORA program creates a binary solution file called 
save.bin.  This file is required by the CHEMKIN Graphical Post-Processor as well as the FORTRAN 
post-processor described below. You should always check for errors by reviewing the contents of 
aurora.out, before proceeding. 
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4. Run the FORTRAN Post-Processor for AURORA, called AURORA_POST: 

Windows/PC:Windows/PC:Windows/PC:Windows/PC: 

..\..\..\bin\ aurora_post < aurora_post.inp >aurora_post.out

UNIXUNIXUNIXUNIX::::  
../../../bin/ aurora_post < aurora_post.inp >aurora_post.out

In the above commands, the “<” and “>” are used to redirect standard input and output, 
respectively, from and to the specified files.  The AURORA_POST program reads the binary solution 
file, save.bin.  In addition to the aurora_post.out output file, which contains diagnostics 
information, the post-processor creates one or more files named *.csv, where the “*” is a prefix 
determined by the input in the aurora_post.inp file.  These files contain rows of comma-
separated values representing the AURORA solution results (such as species mass fractions).  In this 
particular sample, the number of rows is determined by the number of continuations (keyword 
CNTN) included in the AURORA input file.  For transient problems, the number of rows will be the 
number of time steps.   

 
General Note:  All of the Applications in the CHEMKIN Release 3.6 have sample FORTRAN post-
processors.  The release includes full source code for these routines.  The source code is located in 
the “post_processors” directory at the root of the CHEMKIN installation.  These post-processors 
provide examples of how to read the binary solution files for exporting CHEMKIN solution data 
into custom or third-party applications.   

 
 

8.1.5 Command-Line Argument Options 

Table 6 provides a list of the available command-line argument flags for each of the CHEMKIN Pre-
processor and Application programs.  Table 6 also indicates whether each of the input or output files is 
always needed (A) or whether it is optional (O).  For all required files, default file names are provided if 
files are not specified on the command line.  These default file names are listed in the last column in 
Table 6.  The command-line arguments allow specification of full pathnames to input and output files, in 
addition to the file names themselves.  By default, any un-specified path is assumed to be the local 
working directory.  Examples of using the command-line arguments are provided in Section 8.1.4. 
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TableTableTableTable    6  Command6  Command6  Command6  Command----Line Argument Options for Line Argument Options for Line Argument Options for Line Argument Options for CCCCHEMKINHEMKINHEMKINHEMKIN Pre Pre Pre Pre----processors and Applicationsprocessors and Applicationsprocessors and Applicationsprocessors and Applications    

  Application or PreApplication or PreApplication or PreApplication or Pre----processor Program Nameprocessor Program Nameprocessor Program Nameprocessor Program Name    
    
    
    

FlagFlagFlagFlag    

    
    
FileFileFileFile    
DescriptionDescriptionDescriptionDescription    

ch
em

ch
em

ch
em

ch
em

    

su
rf

su
rf

su
rf

su
rf     

tra
n

tra
n

tra
n

tra
n     

au
ro

ra
au

ro
ra

au
ro

ra
au

ro
ra

    

cr
es

la
f

cr
es

la
f

cr
es

la
f

cr
es

la
f     

eq
ui

l
eq

ui
l

eq
ui

l
eq

ui
l     

op
pd

if
op

pd
if

op
pd

if
op

pd
if     

pl
ug

pl
ug

pl
ug

pl
ug

    

pr
em

ix
pr

em
ix

pr
em

ix
pr

em
ix

    

se
nk

in
se

nk
in

se
nk

in
se

nk
in

    

sh
oc

k
sh

oc
k

sh
oc

k
sh

oc
k     

sp
in

sp
in

sp
in

sp
in

    

su
rft

he
rm

su
rft

he
rm

su
rft

he
rm

su
rft

he
rm

        
Default Default Default Default 
File File File File 
NameNameNameName1111    

----iiii    Input A A O A A A A A A A A A A xxx.inp 
----oooo    Output A A A A A A A A A A A A A xxx.out 
----dddd    Data O O A -- -- -- -- -- -- -- -- -- -- yyy.dat 
----rrrr    Restart -- -- -- O O -- O -- O O -- O -- rest.bin 
----bbbb    Binary 

Solution 
-- -- -- A A A A A A A A A -- save.bin 

----cccc    CHEMKIN  
Gas-phase 
Linking 

A A A A A A A A A A A A A chem.asc

----ssss    Surface 
Linking 

-- A -- A A O -- A -- -- -- A A surf.asc 

----tttt    Transport 
Linking  

-- -- A -- A -- A -- A -- -- A O tran.asc 

----vvvv    Recover  -- -- -- A -- -- A -- A -- -- A -- recov.bin
----pppp    Initial 

Profile 
-- -- -- -- O -- -- -- -- -- -- -- -- cres.pro 

----1111    Extra 
Output 
#12 

-- -- -- O A -- -- -- -- -- -- A --  

 
 

8.2 SETTING UP YOUR OWN PROBLEM 

To begin applying CHEMKIN Applications to your own problems, we recommend that you set up a 
working directory where you will store your input and output files for the application you wish to run.  
We also recommend that you add the CHEMKIN “bin” directory (e.g. c:\chemkin36\bin on a PC or 
~/chemkin36/bin for UNIX) to your local “path” definition, so that you don't have to specify the full 
path of the executables every time you run them.  The procedure for modifying path variables is 
described in Chapter 3, Sections 3.2.2 (for PCs) and Section 3.3.4 (for UNIX).  
 

                                                 
1 In the following list “xxx” is used in place of the name of the program executable (e.g. “chem” would have an 
input file named “chem.inp” and an output file named “chem.out”).  The text “yyy” is either “tran” or “therm” for 
the Transport and Thermodynamics database files, respectively. 
2 The Extra Output #1, 2, etc., allow growth for additional output files.  At present, the –1 covers: “last.s” for 
AURORA, “ldas.bin” for CRESLAF, and “flux.out” for SPIN. 
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You can then follow a similar procedure as when running the sample problems in the step-by-step mode, 
but this time you will have to create your own input files.  For this discussion we will use SENKIN as the 
target Application.  The following are the steps for running SENKIN for your own problem.   
 

1. Create the input files that you want to use to describe your reactor and process conditions.  Use the 
text editor you are most comfortable with and save the files to your working directory.  (See the 
Application and Utility user manuals for more guidance in creating the input data.) 

2. Open a MS-DOS Prompt or UNIX shell and change directories to this working directory.  

3. Run the necessary pre-processors. For the SENKIN Application, you will only need to run the 
CHEMKIN Gas-phase Interpreter.  In the example below, we show how to run with your own 
thermodynamic database file located in your local directory.  You can then run the CHEMKIN 
Interpreter by typing the following, assuming that you set your path as suggested above and have 
defined the chemistry in a file named mychem.inp :  

chem -i mychem.inp -o mychem.out –d mytherm.dat

Make sure check the  mychem.out file before proceeding.  For other applications, you may also need to 
run the TRANSPORT pre-processor (which requires the tran.dat file to be copied or linked to the 
local directory) and/or the SURFACE CHEMKIN Pre-processor. To determine which pre-processors and 
input files are needed, see Table 3 in Chapter 5. 

4. Run the Application with your input files. For example, to run SENKIN, you would type:  

senkin -i mysenkin.inp -o mysenkin.out

Again, you would want to check the mysenkin.out file to see if the program ran successfully, 
before attempting to post-process the results.  

5. Run the SENKIN post-processor: 

senkin_post < mysenkin_post.inp > mysenkin_post.out

The SENKIN post-processor (like all of the FORTRAN post-processors) produces a number of text files that 
contain comma-separated values according to the options requested in the mysenkin_post.inp file.  
These text files can easily be imported into the CHEMKIN Graphical Post-Processor, or into other analysis 
tools, such as spread-sheet programs.   
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9. Getting Help and Support 

9.1 ONLINE DOCUMENTATION 

CHEMKIN 3.6 provides a complete set of documentation in the form of HTML pages and PDF documents 
focused precisely on the details of building and running the CHEMKIN software.  Included in the CHEMKIN 
installation are PDF documents for each of the user manuals for the CHEMKIN Utilities and Applications.  
You can view the PDF documents using Adobe  Acrobat Reader .  The HTML pages installed with 
CHEMKIN describe the installation directory structure and the sample problems available for each 
Application.  You can view the HTML files using any internet browser (such as Internet Explorer or 
Netscape Navigator).  The best method for getting started with the online documentation depends on 
your platform: 

Windows/PC:  Windows/PC:  Windows/PC:  Windows/PC:      

In this case, the install program will have placed short-cuts to the HTML pages and to the PDF 
documents in your desktop Start menu.  Selecting a PDF document from the Start menu is 
illustrated in Figure 17 below. 

 

Figure 17. Locating the CHEMKIN user manual PDFs and the HTML Documentation 
from the Windows Desktop Start menu on a PC.   

 

UNIX:  UNIX:  UNIX:  UNIX:      

All of the PDF documents are located in:  $HOME/chemkin36/docs.  The top-level of the 
HTML-based online documentation is:  $HOME/chemkin36/index.html.  Assuming that you 
have the executable for Adobe Acrobat Reader in your path, you may type: 

acroread getting_started.pdf <RETURN>
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to open a PDF of this document in the Acrobat Reader.  Alternatively, most web browsers include 
a plug-in for Acrobat Reader, so that you can open a PDF directly from the web browser.  For 
example, if you have Netscape installed on your computer and in your path, then you could type: 

netscape getting_started.pdf <RETURN>

to open the PDF from within Netscape.  Similarly you can use the web browser from the 
command line to open the top-level “index.html” for browsing the HTML documentation. 

9.2 FREQUENTLY ASKED QUESTIONS 

Reaction Design provides a set of answers to Frequently Asked Questions (FAQs) that we have compiled 
through our interaction with customers.    The up-to-date list of FAQs is maintained in the Customer 
Support section of our website (www.ReactionDesign.com). 
 

9.3 CONTACTING TECHNICAL SUPPORT 

Reaction Design is committed to the highest level of technical support.   If the answer to your question is 
not found in the Frequently Asked Questions (FAQ) section, please email your question to 
Support@ReactionDesign.com. You may also contact Reaction Design's Technical Support, by 
Fax: (858) 550-1925, or by Phone: (858) 550-1920.  
 
If you call or send email, you should include the following information in your support request:  
 

1. Your CHEMKIN License Number.  

2. The name and email address of the Licensee, if different from yourself.  

3. Any input or output files for the problem you are running.  

4. Any pertinent error or informational messages you have received from the CHEMKIN software.  
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Main Office: 
Reaction Design 
6440 Lusk Boulevard 
Suite D-209 
San Diego, CA 92121-2758 
(858) 550-1920 (telephone) 
(858) 550-1925 (fax) 
info@Reaction Design.com (email) 
www.ReactionDesign.com 
 

CHEMKIN Distributor in Japan: 
Best Systems 
2-1-6 Sengen 
Tsukuba Ibaraki 305-0047 Japan 
81-298-60-7080 (telephone) 
81-298-60-7081 (fax)  
wta@bestsystems.co.jp (email) 
 

CHEMKIN Distributor in Korea: 
Reaction Engineering Korea 
1404, DongA officetel 538-8,  
BongMyung-dong, YuSung-ku, Taejon,  
KOREA 
82-42-828-7741 (telephone) 
82-42-828-7742 (fax) 
smpark@RxnEng.co.kr (email) 
www.RxnEng.co.kr 
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